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Resumo
Neste trabalho, objetivou-se a realização de um estudo acerca de um problema de fluxo de
calor em uma haste fina, aplicando métodos de resolução analítica e numérica para obter a
solução da equação diferencial parcial (EDP) que governa o problema de valor de contorno
(PVC) analisado e, assim, realizar comparações entre os resultados encontrados. O PVC
em questão trata da condução de calor em uma haste fina aquecida com uma temperatura
inicial por todo o seu comprimento cujas as extremidades são mantidas à temperatura zero.
Este problema é descrito por uma EDP parabólica de segunda ordem linear denominada
equação do calor unidimensional, que determina a variação de temperatura em um meio
com o passar do tempo. Para determinar a solução analítica do PVC utilizou-se o método
da separação de variáveis, quanto à solução numérica, utilizou-se o método das diferenças
finitas (MDF), subtituindo-se as derivadas da equação original por fórmulas de diferenças
finitas, gerando um sistema de equações algébricas. Frente as soluções obtidas, verificou-se
a eficiência do método numérico ao comparar os resultados analíticos com os numéricos e
constatar um baixo erro relativo entre eles.

Palavras-chave: Problema de valor de contorno. Equação diferencial parcial. Equação do
calor. Variação de temperatura. Método das diferenças finitas.



Abstract
In this work, the objective was to carry out a study about a thin rod heat flux problem,
applying analytical and numerical solving methods to obtain the solution of the partial
differential equation (PDE) that governs the boundary value problem (BVP) analyzed
and, thus, make comparisons between the results found. The BVP in question deals with
the conduction of heat in a thin heated rod with an initial temperature along its entire
length whose ends are kept at zero temperature. This problem is described by a linear
second-order parabolic PDE called the one-dimensional heat equation, which determines
the change in temperature in a medium over time. To determine the analytical solution of
BVP, the variable separation method was used, as for the numerical solution, the finite
difference method (FDM) was used, replacing the derivatives of the original equation
by finite difference formulas, generating a system of algebraic equations. Based on the
solutions obtained, the efficiency of the numerical method was verified by comparing the
analytical results with the numerical ones and finding a low relative error between them.

Keywords: Boundary value problem. Partial differential equation. Heat equation. Tem-
perature variation. Finite difference method.
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1 INTRODUÇÃO

Neste trabalho será realizado um estudo sobre o fluxo de calor em uma haste
fina, com o intuito de obter a modelagem matemática que representa o problema. Este
problema que envolve a condução de calor em um sólido é descrito pela Equação do
Calor unidimensional, a qual iremos obter a solução analítica pelo método de separação
de variáveis e a numérica por meio do método das diferenças finitas (MDF). Para que
o objetivo seja alcançado, primeiramente será feita uma revisão bibliográfica sobre as
equações diferenciais parciais, problemas de valor de contorno e os métodos de resolução
analítico e numérico.

As equações diferenciais podem ser definidas como equações que contém derivadas
e podem ser classificadas de acordo com o tipo, a ordem e a linearidade. Em particular,
quanto ao tipo, existem as equações diferenciais parciais (EDPs) que envolvem derivadas
parciais de uma ou mais variáveis dependentes com relação a duas ou mais variáveis
independentes. Nesse sentido, observa-se uma vasta variedade de aplicações em diversas
áreas de conhecimento, como em ciências, engenharia, economia e até mesmo em psicologia,
onde se deseja modelar o comportamento de algum fenômeno em termos matemáticos
(ZILL; CULLEN, 2007).

A modelagem de sistemas por meio de equações diferenciais é uma ferramenta
poderosa que apresenta aplicação em situações como o aumento ou diminuição de popu-
lações, a propagação de epidemias, a competição de espécies, a dissipação de calor em
objetos sólidos, etc. A partir dos modelos matemáticos é possível representar tanto sistemas
simples quanto sistemas mais complexos, fornecendo assim uma descrição aproximada e
simplificada do processo real (THOMAS, 2013).

O estudo significativo sobre os modelos matemáticos, as equações que os descrevem
e suas soluções são indispensáveis para compreender os procedimentos de solução de
problemas reais. A solução é necessária para que se possa fazer previsões sobre como se
comporta o processo que a equação diferencial se propõem a modelar (BOYCE; DIPRIMA,
2006).

Por sua vez, as equações diferenciais parciais são de extrema importância para
resolução de problemas mais amplos, especialmente fenômenos que envolvem a condução
de calor. A equação diferencial que governa a condução de calor em sólidos é denominada
Equação de Calor. No entanto, para determinar o fluxo de calor em uma barra, é preciso
solucionar essa equação diferencial parcial sujeita à condições de contorno e à uma condição
inicial (BOYCE; DIPRIMA, 2006).

Contudo, a resolução de uma equação diferencial parcial pode ser uma tarefa difícil.
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Por conta das condições de contorno impostas ao problema, a obtenção de uma solução
exata por algum método analítico existente, torna-se muito complicada ou até mesmo
impossível. Nestes casos, é possível encontrar uma solução aproximada obtida através da
utilização de métodos numéricos (VIANA, 2018).

Existem nos dias atuais, inúmeros métodos numéricos utilizados para solução de
problemas, entre eles, destaca-se o Método das Diferenças Finitas. Nesse método, é efetuado
o processo de discretização do domínio considerado e a EDP é então transformada em um
sistema de equações algébricas, substituindo as derivadas por diferenças finitas. O método
numérico das diferenças finitas é facilmente executado em computadores para sistemas
em que utiliza-se a discretização por uma malha uniforme, assim, são utilizados softwares
como o Scilab para facilitar a resolução (CHAPRA; CANALE, 2008).

O Scilab é um software livre de alto rendimento, com linguagem de programação
mais simples e que pode ser utilizado para resolver cálculos de certa complexidade. Além
disso, apresenta uma variedade de funções matemáticas e ferramentas (MAIA-AFONSO;
DIAS, 2020).

Diante do que foi apresentado, este trabalho pretente seguir os seguintes passos:
modelar o problema da propagação do calor unidimensional em uma haste fina, obter a
solução analítica e comparar com a solução numérica que será obtida pelo método das
diferenças finitas.

Assim, neste trabalho, inicialmente trataremos de uma revisão bibliográfica sobre
as equações diferenciais ordinárias, equações diferenciais parciais e sobre problemas de
valor de contorno. Também será feito um estudo sobre os métodos analíticos e numéricos
para resolução das EDPs, em particular, o método da separação de variáveis e o método
das diferenças finitas. Por fim estudaremos a Equação do Calor e utilizaremos os métodos
para obter a sua solução analítica e numérica.
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1.1 Objetivos

1.1.1 Objetivo Geral

Modelar o fluxo de calor em uma haste fina, obter a solução analítica da equação
governante e comparar com a solução numérica obtida pelo método das diferenças finitas.

1.1.2 Objetivos Específicos

• Realizar um estudo inicial sobre as equações diferenciais parciais;

• Reconhecer problemas de valor de contorno;

• Estudar o método de resolução analítico que pode ser aplicado para resolver a
equação do calor unidimensional;

• Determinar o problema de valor de contorno que representa o fluxo de calor em uma
haste fina;

• Obter a solução analítica da equação do calor aplicada a uma haste fina;

• Compreender as características e aplicabilidade do método das diferenças finitas;

• Obter a solução numérica por meio do método das diferenças finitas;

• Comparar a solução analítica e numérica utilizando o software Scilab.
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1.2 Justificativa
O estudo de fenômenos de condução do calor representa uma área importante para

as ciências exatas, devido às diversas situações que envolvem a transferência de energia
térmica. Problemas que envolvem a difusão de calor podem ser descritos por uma equação
diferencial parcial denominada equação do calor.

As equações diferenciais possuem grande relevância para muitas áreas da ciência e da
engenharia, especialmente por apresentarem aplicações em diversos fenômenos do cotidiano.
Além disso, o estudo sobre as equações diferenciais em problemas contextualizados permite
uma aproximação entre a teoria e a prática, visto que muitos alunos dominam as técnicas
de resolução analítica mas têm dificuldades em solucionar problemas. Em particular,
as equações diferenciais parciais constituem uma importante ferramenta para descrever
situações reais através de um modelo matemático.

Contudo, a resolução de uma equação diferencial parcial pode ser complexa, difi-
cultando ou até mesmo impossibilitando a obtenção de soluções analíticas. Desta forma,
é possível obter uma solução aproximada por meio da utilização de métodos numéricos,
como o Método das Diferenças Finitas (MDF). Destaca-se que o MDF é muito utilizado na
engenharia para solucionar numericamente problemas que envolvem equações diferenciais
parciais com valores de contorno.
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2 REFERENCIAL TEÓRICO

2.1 Equações Diferenciais Ordinárias
As equações diferenciais, de um modo geral, constituem uma ferramenta impres-

cindível tanto para a matemática aplicada, quanto para a pura, sendo aperfeiçoada e
desenvolvida durante muitos anos por importantes matemáticos, cujas contribuições foram
cruciais para desenvolver os fundamentos deste assunto (SILVA, 2014).

De acordo com Boyce e DiPrima (2006), uma equação diferencial é uma lei, ou
uma prescrição, que estabelece a taxa segundo a qual as coisas acontecem. Expressas em
linguagem matemática, as taxas são derivadas e as relações são equações que regem o
comportamento de algum processo físico.

Assim, uma equação diferencial relaciona determinada função com suas derivadas
e para resolvê-la é necessário determinar a função que a satisfaz. Desta forma, segundo
Zill e Cullen (2007), define-se:

Definição 2.1 Uma equação que contém as derivadas ou diferenciais de uma ou mais
variáveis dependentes, em relação a uma ou mais variáveis independentes, é chamada de
equação diferencial (ED).

Existem fundamentalmente dois tipos de equações diferenciais, as equações diferen-
ciais ordinárias (EDOs) e as equações diferenciais parciais (EDPs). No entanto, para um
estudo eficiente acerca das EDPs, é necessário dominar os conceitos e propriedades básicas
das EDOs, pois, quando conveniente, para chegar à solução do problema, busca-se simpli-
ficar os cálculos transformando a EDP em uma ou mais equações diferenciais ordinárias
(SILVA, 2016).

Segundo Boyce e DiPrima (2006), a classificação em EDO ou EDP diz respeito
à quantidade de variáveis independentes envolvidas, ou seja, se a função desconhecida
depende de uma única variável independente ou de diversas variáveis independentes.

Além da classificação quanto ao tipo, Zill e Cullen (2007) apontam que as equações
diferenciais também podem ser classificadas de acordo com a ordem e a linearidade.

2.1.1 Classificação quanto ao tipo, ordem e linearidade

Na classificação quanto ao tipo, tem-se as equações diferenciais ordinárias e as
equações diferenciais parciais, que segundo Zill e Cullen (2007) podem ser definidas como:
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Definição 2.2 Se uma equação contém somente derivadas ordinárias de uma ou mais
variáveis dependentes, com relação a uma única variável independente, ela é chamada de
equação diferencial ordinária (EDO).

São exemplos de equações diferenciais ordinárias,

dy

dx
− 5y = 0, (2.1)

d2y

dx2 = x, (2.2)

(
du

dy

)3

− 2dv

dy
+ 6y = 0. (2.3)

Nota-se que em (2.1) e (2.2) há uma variável independente x e apenas uma variável
dependente y. Porém, a EDO (2.3) contém uma variável independente y e duas variáveis
dependentes u e v.

Definição 2.3 Se uma equação envolve as derivadas parciais de uma ou mais variá-
veis dependentes de duas ou mais variáveis independentes, ela é chamada de equação
diferencial parcial (EDP).

Como exemplos de EDPs têm-se,

∂u

∂y
+ ∂v

∂x
= 0, (2.4)

x

(
∂u

∂x

)2

+ y
∂u

∂y
= 3, (2.5)

∂4u

∂x4 + ∂2u

∂y2 = −2∂u

∂y
. (2.6)

Verifica-se que em (2.4) há duas variáveis dependentes u e v, e duas variáveis
independentes x e y. Enquanto em (2.5) e (2.6) há uma variável dependente u em relação
a duas variáveis independentes x e y.

Outra classificação existente decorre da ordem da equação diferencial que, segundo
Zill e Cullen (2007), é dada pela ordem da mais alta derivada que aparece na expressão.
Assim, pode-se classificar (2.1) e (2.3) como equações diferenciais ordinárias de primeira
ordem e (2.2) como equação diferencial ordinária de segunda ordem.
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De maneira geral, Boyce e DiPrima (2006) apontam que uma equação diferencial
ordinária de n-ésima ordem com uma variável dependente y pode ser representada da
forma,

F (x, y, y′, ..., yn) = 0, (2.7)

onde F é uma função de valores reais com n + 2 variáveis em que yn = dny
dxn .

Além disso, quando se é possível explicitar a n-ésima derivada na equação (2.7),
obtém-se a EDO

y(n) = f(x, y, y′, ..., y(n−1)), (2.8)

a qual é denominada de forma normal de F .

As equações diferenciais são classificadas também, quanto a sua linearidade. Assim,
conforme Boyce e DiPrima (2006), uma equação diferencial do tipo (2.7) é dita linear se F

é uma função linear das variáveis y, y′, ..., yn. De maneira análoga, a definição é aplicada
nas equações diferenciais parciais. Desse modo, a forma geral de uma EDO linear de ordem
n é dada por

an(x)dny

dxn
+ an−1(x)dn−1y

dxn−1 + ... + a1(x)dy

dx
+ a0(x)y = g(x). (2.9)

Analisando a equação (2.9), Zill e Cullen (2007) apresentam as duas propriedades
que caracterizam a linearidade de uma equação diferencial.

(i) A variável dependente y e todas as suas derivadas são do primeiro grau, isto é, a
potência de cada termo envolvendo y é 1.

(ii) Cada coeficiente depende apenas da variável independente x.

Uma equação que não satisfaz as condições anteriores é chamada de não linear.

É importante destacar que os métodos utilizados para resolver equações lineares
estão bastante desenvolvidos em comparação com a teoria matemática para equações não
lineares. Sendo assim, é favorável que os problemas que envolvem equações diferenciais
não lineares sejam aproximados por equações lineares, processo este que recebe o nome de
linearização (BOYCE; DIPRIMA, 2006).

Uma EDO linear de ordem n é dita homogênea se g(x) = 0 na expressão (2.9), ou
seja,

an(x)dny

dxn
+ an−1(x)dn−1y

dxn−1 + ... + a1(x)dy

dx
+ a0(x)y = 0, (2.10)

caso contrário, a equação é considerada não-homogênea.
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2.1.2 Soluções de equações diferenciais ordinárias

Ao se deparar com problemas que envolvem equações diferenciais, tem-se como
objetivo encontrar suas soluções. Desta forma, de acordo com Zill e Cullen (2007), tem-se
que:

Definição 2.4 Qualquer função f definida em algum intervalo I, que, quando substituída
na equação diferencial, reduz a equação a uma identidade, é chamada de solução para a
equação no intervalo.

Ou seja, a solução de uma EDO na forma da equação (2.8) é uma função f que
possui pelo menos n derivadas e satisfaz a equação, isto é,

F (x, f(x), f ′(x), ..., fn(x)) = 0 (2.11)

para todo x no intervalo I. Ressalta-se que o intervalo I, conhecido por intervalo de
definição, intervalo de existência, intervalo de validade ou domínio da solução, pode
representar um intervalo aberto, fechado ou até mesmo infinito (ZILL, 2012).

As equações diferenciais podem admitir infinitas soluções, exatamente uma ou
nenhuma solução. Em particular, quando resolvemos uma equação diferencial de ordem n,
estamos procurando um número infinito de soluções correspondentes ao número ilimitado
de opções dos parâmetros, formando assim uma família de soluções, na qual a função nula,
chamada solução trivial, está inserida (ZILL, 2012).

Além disso, quando a equação diferencial não depende de parâmetros arbitrários,
obtém-se uma solução particular, de modo que a solução geral é dada pelo conjunto
de todas as soluções. Para encontrar uma solução particular, basta determinar valores
específicos para os parâmetros na família de soluções (ZILL; CULLEN, 2007).

Uma equação diferencial que satisfaça determinadas condições auxiliares sobre a
função incógnita e suas derivadas constituem problemas de valor inicial ou problemas de
valor de contorno, assunto que será detalhado nas subseções (2.1.3) e (2.1.4). Para encontrar
a solução de problemas de valor inicial ou de contorno, é necessário determinar uma função
que, simultaneamente, resolve a equação diferencial e satisfaz todas as condições auxiliares
especificadas (BRONSON; COSTA, 2008).

2.1.3 Problema de valor inicial

De acordo com Zill (2012), um problema de valor inicial (PVI) é formado por uma
equação diferencial e por condições auxiliares impostas a uma função desconhecida e suas
derivadas em um ponto x0. Assim, a equação diferencial (2.9), definida em algum intervalo
I contendo x0, quando sujeita às condições iniciais y(x0) = y0, y′(x0) = y1, ..., y(n−1)(x0) =
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yn−1 especificadas no ponto x0, tem-se um PVI que pode ser expresso como,
an(x)dny

dxn
+ an−1(x)dn−1y

dxn−1 + . . . + a1(x)dy

dx
+ a0(x)y = g(x)

y(x0) = y0, y′(x0) = y1, . . . , y(n−1)(x0) = yn−1.
(2.12)

Para resolver um problema de valor inicial de ordem n da forma (2.12), é preciso
determinar as constantes na família de soluções a n parâmetros da equação diferencial
dada, por meio da aplicação das n condições iniciais de x0, resultando assim, na solução
particular para algum intervalo I que contém o ponto inicial x0 (ZILL, 2012).

Além disso, Zill (2012) enuncia um teorema que dá condições suficientes para a
existência e a unicidade de soluções de um problema de valor inicial:

Teorema 2.5 Sejam an(x), an−1(x), ..., a1(x), a0(x) e g(x) contínuas em um intervalo I

e seja an(x) ̸= 0 para todo x nesse intervalo. Se x = x0 for um ponto qualquer nesse
intervalo, então existe uma única solução y(x) do PVI (2.12) nesse intervalo.

2.1.4 Problema de valor de contorno

Um problema de valor de contorno (PVC) é um tipo de problema que envolve uma
equação diferencial linear de segunda ordem ou superior, no qual a variável dependente y

ou suas derivadas são especificadas em pontos diferentes, sujeita à condições auxiliares
denominadas condições de contorno (ZILL, 2012).

De acordo com Zill e Cullen (2007), um PVC composto por uma equação diferencial
de ordem n sujeita a n condições de contorno é dado por,

an(x)dny

dxn
+ an−1(x)dn−1y

dxn−1 + . . . + a1(x)dy

dx
+ a0(x)y = g(x)

y(x0) = y0, y′(x1) = y1, . . . , y(n−1)(xn−1) = yn−1,
(2.13)

em que y0, y1, ..., yn−1 são constantes reais. Um problema de valor de contorno na forma
(2.13) pode ter muitas soluções, uma única ou nenhuma solução, mesmo quando as
condições do Teorema de Existência e Unicidade (2.5) estiverem satisfeitas.

Os problemas de valor de contorno são tratados frequentemente para caracterizar
sistemas de engenharia em que a variável tempo aparece, como por exemplo, a distribuição
estacionária de temperatura em uma haste fina aquecida (CHAPRA; CANALE, 2008).

2.1.5 Dependência Linear e Independência Linear

Com o propósito de determinar as soluções das EDOs, é imprescindível o estudo de
alguns conceitos básicos sobre as EDOs lineares de ordem superior, os quais são expostos
nesta seção.
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Definição 2.6 Um conjunto de funções f1(x), f2(x), ..., fn(x) é dito linearmente de-
pendente em um intervalo I, se existem constantes c1, c2, ..., cn não todas nulas, tais
que

c1f1(x) + c2f2(x) + ... + cnfn(x) = 0

para todo x no intervalo. Caso contrário, se o conjunto de funções não é linearmente
dependente no intervalo, esse conjunto é dito linearmente independente (ZILL, 2012).

Para exemplificar essas definições, considera-se duas funções f1(x) e f2(x) linear-
mente dependentes em um intervalo, deste modo

c1f1(x) + c2f2(x) = 0, (2.14)

tal que as constantes c1 e c2 não são ambas nulas. Supondo c1 ̸= 0, segue-se que

f1(x) = −c2

c1
f2(x), (2.15)

isto é, uma é simplesmente uma constante múltipla da outra. Desta forma, segundo Zill
(2012), um conjunto de funções f1(x), f2(x), ..., fn(x) é dito linearmente dependente em
um intervalo, se ao menos uma função pode ser expressa como uma combinação linear das
funções restantes.

Para verificar a independência linear das n soluções de uma EDO linear homogênea
de ordem n, utiliza-se o chamado wronskiano das funções.

Definição 2.7 Considerando que f1(x), f2(x), ..., fn(x) sejam diferenciáveis pelo menos
n − 1 vezes, então, o determinante

W (f1, f2, ..., fn) =

∣∣∣∣∣∣∣∣∣∣∣∣

f1 f2 . . . fn

f ′
1 f ′

2 . . . f ′
n

... ... . . . ...
f

(n−1)
1 f

(n−1)
2 . . . f (n−1)

n

∣∣∣∣∣∣∣∣∣∣∣∣
é chamado de Wronskiano das funções.

Com base no wronskiano, é estabelecido um teorema que proporciona condição
suficiente para a independência linear de funções.

Teorema 2.8 O conjunto (f1(x), f2(x), ..., fn(x)) de n soluções para a equação diferencial
homogênea (2.10) é linearmente independente em I se, e somente se, o wronskiano dessas
funções for diferente de zero.
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Quando considera-se as soluções de uma EDO linear de n-ésima ordem homogênea,
vale o princípio da superposição, conforme o Teorema (2.9), o qual determina que a soma
de duas ou mais soluções é também uma solução.

Teorema 2.9 Sejam y1, y2, ..., yk soluções para a equação diferencial linear de n-ésima
ordem homogênea da forma (2.10), em um intervalo I. Então, a combinação linear

y = c1y1(x) + c2y2(x) + ... + ckyk(x),

em que ci, i = 1, 2, ..., k, são constantes arbitrárias, é também uma solução no intervalo.

A partir do Teorema (2.9), segue-se que um múltiplo y = c1y1(x) de uma solução
y1(x) para uma equação diferencial linear homogênea é também uma solução. Além disso,
uma EDO linear homogênea sempre possui uma solução trivial y = 0.

O conjunto de n soluções linearmente independentes para a equação diferencial
linear homogênea de n-ésima ordem (2.10) é chamado de conjunto fundamental de
soluções no intervalo. Em um conjunto fundamental de soluções pode-se definir a solução
geral da equação no intervalo I, a qual é dada por

y = c1y1(x) + c2y2(x) + ... + cnyn(x), (2.16)

em que os ci, i = 1, 2, ..., n são constantes arbitrárias (ZILL, 2012).

Quanto às EDOs lineares não-homogêneas, tem-se que qualquer função yp, indepen-
dente de parâmetros, que satisfaça a expressão (2.9), é chamada de solução particular
para a equação. Assim, seja yp uma solução qualquer para a equação não-homogênea (2.9)
em um intervalo I e sejam y1, y2, ..., yn um conjunto fundamental de soluções para a EDO
homogênea associada (2.10) no intervalo, então, a solução geral da equação em I é dada
por,

y = c1y1(x) + c2y2(x) + ... + cnyn(x) + yp, (2.17)

onde c1, c2, ..., cn são constantes arbitrárias (ZILL, 2012).

A combinação linear yc(x) = c1y1(x) + c2y2(x) + ... + cnyn(x) em (2.17) é chamada
de função complementar para a EDO. Portanto, a solução geral para uma EDO linear
não-homogênea é definida por

y = yc + yp. (2.18)

2.2 Equações Diferenciais Parciais
Como já exposto na seção (2.1), as equações diferenciais parciais (EDPs) são

equações que envolvem as derivadas parciais de uma ou mais variáveis dependentes, com
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relação a duas ou mais variáveis independentes, ou seja, equações que contém as derivadas
parciais de uma função de várias variáveis (ZILL; CULLEN, 2007).

Conforme Iório (2018), de maneira mais precisa, uma equação diferencial parcial que
envolve a variável dependente u e n variáveis independentes x1, ..., xn, pode ser representada
pelo simbolismo

F
(

x1, ..., xn, u,
∂u

∂x1
, ...,

∂u

∂xn

,
∂2u

∂x2
1
, ...,

∂2u

∂x1∂xn

, ...,
∂ku

∂xk
n

)
= 0, (2.19)

onde F é uma função das variáveis indicadas e u = u(x1, ..., xn) é a função que se deve
determinar.

É importante salientar que a classificação de EDPs quanto a ordem e a linearidade
é análoga à classificação das equações diferenciais ordinárias. Desta maneira, a ordem de
uma EDP é dada pela derivada parcial de maior ordem que ocorre na equação, assim, a
equação (2.19) pode ser classificada como uma equação diferencial parcial de ordem k

(IÓRIO, 2018).

Quanto a linearidade de uma EDP, que será detalhada na subseção (2.2.1), frisamos
que não abordaremos neste trabalho as equações não lineares, visto que o problema relativo
ao fluxo de calor em uma haste fina é descrito por uma equação diferencial parcial linear
de segunda ordem.

2.2.1 EDP Linear

Como mencionado anterioremente, podemos classificar equações diferenciais parciais
como lineares ou não lineares de forma semelhante à classificação das EDOs. Deste modo,
uma EDP é dita linear se a variável dependente e suas derivadas parciais aparecem somente
elevadas à primeira potência (IÓRIO, 2018).

De acordo com Zill e Cullen (2009), a forma geral de uma equação diferencial parcial
de segunda ordem linear, que envolve a variável dependente u e as variáveis independentes
x e y, pode ser representada por

A
∂2u

∂x2 + B
∂2u

∂x∂y
+ C

∂2u

∂y2 + D
∂u

∂x
+ E

∂u

∂y
+ Fu = G, (2.20)

onde os coeficientes A, B, C, ..., G são constantes ou funções de x e y.

Quando o termo que não contém a variável dependente for igual a 0, ou seja,
G(x, y) = 0, chamaremos a equação (2.20) de homogênea, caso contrário, a classificaremos
como não homogênea (ZILL; CULLEN, 2009).

Como, por exemplo, são equações diferenciais parciais lineares

∂2u

∂x2 + ∂2u

∂y2 = 0, (2.21)
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∂2u

∂x2 − ∂u

∂y
= xy, (2.22)

em que (2.21) é homogênea e (2.22) é não homogênea.

2.2.2 Solução de uma EDP

Segundo Zill e Cullen (2009), para encontrar a solução de uma equação diferencial
parcial linear da forma (2.20), é preciso determinar uma função u(x, y) de duas variáveis
independentes que possui todas as derivadas parciais ocorrendo na equação e que satisfaça
a equação em alguma região do plano xy.

Neste trabalho, não abordaremos os procedimentos para obter soluções gerais de
uma equação diferencial parcial linear, visto que a obtenção de soluções gerais para estes
tipos de equações não é simples, e nem sempre é útil em aplicações. Desta forma, nossa
intenção será explorar procedimentos para obtenção de soluções particulares de EDPs
lineares (ZILL; CULLEN, 2009).

2.2.3 Método da separação de variáveis

Durante os dois últimos séculos, foram desenvolvidos diversos métodos para se
resolver equações diferenciais parciais. Dentre estes, o método de separação de variáveis
é o método analítico mais antigo, tendo sido essencial nas investigações sobre ondas e
vibrações feitas pelos matemáticos D’Alembert, Daniel Bernoulli e Euler em torno do ano
de 1750 (COSTA; DIAS, 2018).

Apesar dos muitos métodos existentes, Zill e Cullen (2009) abordam o método
da separação de variáveis para a obtenção de soluções particulares de uma EDP linear,
método este que consiste em determinar uma solução particular que pode ser escrita como
um produto entre uma função x e uma função y,

u(x, y) = X(x)Y (y). (2.23)

Considerando esta afirmação, observa-se que em alguns casos é possível reduzir
uma EDP linear que envolve duas variáveis independentes a duas EDOs, como ocorre em

∂u

∂x
= X ′Y,

∂u

∂y
= XY ′,

∂2u

∂x2 = X ′′Y,
∂2u

∂y2 = XY ′′,

onde o apóstrofo representa uma diferenciação ordinária.

Contudo, a separação de variáveis não é considerado um método geral para obtenção
de soluções particulares devido a existência de EDPs lineares que não são separáveis (ZILL;
CULLEN, 2009).
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2.2.4 Princípio da Superposição

Uma propriedade fundamental para o estudo das equações diferenciais parciais é o
Princípio da Superposição, que baseia a aplicação do método da separação de variáveis de
EDPs. Desta maneira, Zill e Cullen (2009) enunciam o seguinte teorema:

Teorema 2.10 (Princípio da superposição) Se u1, u2, ..., uk forem soluções de uma
equação diferencial parcial linear homogênea, então a combinação linear

u = c1u1 + c2u2 + ... + ckuk,

onde ci, com i = 1, 2, ..., k são constantes, é também uma solução.

Além disso, sempre que tivermos um conjunto infinito u1, u2, u3, ... de soluções de
uma equação linear homogênea, podemos ainda construir outra solução u formando a série
infinita

u =
∞∑

k=1
ckuk (2.24)

onde ck, k = 1, 2, ..., são constantes (ZILL; CULLEN, 2009).

2.2.5 Classificação das EDPs

Uma equação diferencial parcial de segunda ordem linear, com duas variáveis
independentes de coeficientes constantes, pode ser classificada como hiperbólica, parabólica
ou elíptica, dependendo apenas dos coeficientes das derivadas de segunda ordem. Assim,
de acordo com Zill e Cullen (2009), considerando que ao menos um dos coeficientes A, B

e C não seja zero, define-se

Definição 2.11 A equação diferencial parcial de segunda ordem linear

A
∂2u

∂x2 + B
∂2u

∂x∂y
+ C

∂2u

∂y2 + D
∂u

∂x
+ E

∂u

∂y
+ Fu = 0, (2.25)

onde A, B, C, D, E e F são constantes reais, é dita ser

hiperbólica se B2 − 4AC > 0,

parabólica se B2 − 4AC = 0,

elíptica se B2 − 4AC < 0.

Desta forma, Siqueira (2019) aponta que a equação (2.25) é considerada elíptica
quando as suas raízes são complexas, hiperbólica quando as raízes da equação são reais e
distintas, e parabólica quando possui raízes reais e alguma é repetida.
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As equações elípticas estão relacionadas, em geral, com problemas de equilíbrio
que não dependem do tempo, como problemas de difusão, pressão e elasticidade. As
equações hiperbólicas, ao longo da variação temporal, podem propagar resultados não
suaves que ocasionam choques, como a equação da onda. Já as equações parabólicas
modelam fenômenos que evoluem com o tempo e a solução, em um ponto interior, depende
da condição inicial, como, por exemplo, a equação do calor (SIQUEIRA, 2019).

Esta classificação é fundamental quando desejamos resolver equações diferenciais
parciais sujeitas a determinadas condições iniciais e de contorno, devido o fato de que os
tipos de condições laterais apropriadas para uma dada equação dependem se a equação é
hiperbólica, parabólica ou elíptica (ZILL; CULLEN, 2009).

2.3 Método das Diferenças Finitas
As equações diferenciais são ferramentas indispensáveis para resolução de problemas

nos mais diversos campos da ciência, devido o fato de descreverem matematicamente
grande parte dos processos reais. Contudo, nem sempre as equações diferenciais possuem
solução analítica, o que requer a utilização de métodos numéricos para a obtenção de
soluções aproximadas (DIAS et al., 2020).

De acordo com Nascimento e Silva (2013), os métodos numéricos surgiram em
virtude do avanço computacional, juntamente com essa necessidade de se obter soluções
de questões cada vez mais complexas. A ideia principal destes métodos é a discretização,
que reduz o problema contínuo, com um número infinito de variáveis, em um problema
discreto, com um número finito de variáveis.

Desta forma, o uso e o desenvolvimento dos métodos numéricos aumentou significa-
tivamente, desde o fim da década de 1940, devido a vasta disponibilidade dos computadores
digitais. Mais ainda recentemente, com a evolução dos computadores pessoais baratos
que fornecem pronto acesso a recursos computacionais poderosos. Assim, os métodos
numéricos se tornaram ferramentas essenciais na resolução de problemas, pois são capazes
de lidar com um grande número de equações que são impossíveis de resolver analiticamente
(CHAPRA; CANALE, 2008).

Por meio da aplicação de métodos numéricos objetiva-se, portanto, encontrar uma
solução numérica próxima da solução exata do problema, visando sempre diminuir a
diferença entre as duas soluções, de modo que o método seja considerado válido. Existem
atualmente inúmeros métodos numéricos utilizados para a solução de problemas científicos,
contudo, neste trabalho iremos evidenciar o chamado de Método das Diferenças Finitas
(MDF) (SILVA, 2016).

O MDF é um método satisfatório para encontrar soluções numéricas de EDPs,
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contudo, iremos inicialmente apresentar alguns desenvolvimentos com foco nas EDOs.

A ideia básica do método das diferenças finitas, de acordo com Lopes e Ruggiero
(1996), consiste em aproximar as derivadas que aparecem na equação original por fórmulas
de diferenças finitas que dependem apenas da função incógnita, gerando assim um sistema
de equações algébricas que pode ser resolvido pelos métodos existentes de resolução de
sistemas.

No MDF, por meio do processo de discretização, o domínio contínuo da equação é
substituído por uma malha de pontos, e assim baseia-se em resolver a equação diferencial
somente em pontos discretos do domínio. Esse processo de discretização se dá pela
subdivisão da área de interesse em pequenas regiões retangulares finitas com dimensões
∆x e ∆y previamente estabelecidas, onde a malha é gerada por meio da intersecção dessas
regiões (VIANA, 2018).

Desta forma, segundo Lopes e Ruggiero (1996), para aplicação do método considera-
se um intervalo de solução [a, b], em que a = x0 e b = xn, então divide-se o intervalo

[a, b] em n partes iguais de comprimento h = (b − a)
n

, cada. A partir dessa subdivisão do
intervalo contínuo, faz-se a discretização do domínio, e assim pode-se definir os demais
pontos xk pertencentes ao domínio discreto e aproximar os valores de yk por,

xk = x0 + kh, k = 0, 1, 2, ..., (n − 1), (2.26)

yk ≃ y(xk) = y(x0 + kh), k = 0, 1, 2, ..., n. (2.27)

As aproximações por meio de diferenças finitas mais utilizadas para as derivadas
de primeira ordem no ponto xi, são as diferenças centrada (2.28), progressiva (2.29) e
regressiva (2.30), indicadas respectivamente pelas equações,

y′(xi) ≃ yi+1 − yi−1

2h
, (2.28)

y′(xi) ≃ yi+1 − yi

h
, (2.29)

y′(xi) ≃ yi − yi−1

h
. (2.30)

Do ponto de vista geométrico, estas aproximações por meio de diferenças finitas
centrada, progressiva e regressiva podem ser verificadas na Figura 1, onde estão sendo
ilustradas juntamente com a derivada exata no ponto xi.

Quando utilizamos essas diferenças finitas para aproximar as derivadas, um erro é
cometido. Deste modo, utilizando a série de Taylor é possível expandir essas diferenças
para medir o erro cometido (LOPES; RUGGIERO, 1996).
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Figura 1 – Aproximações da derivada por meio de diferenças progressiva (dpro), centrada
(dce) e regressiva (dre) juntamente com a derivada exata (dex) da função f(x)

Fonte: Os autores (2021)

De acordo com Guidorizzi (2001), dada uma função y(x) derivável até a ordem n

no intervalo I = [a, b], em que xi pertence a I, é possível aproximar y pelo polinômio de
Taylor, de modo que o polinômio de n-ésima ordem de y em volta de xi é dado por,

Pn(x) = y(xi) + y′(xi)(x − xi) + y′′(xi)
2! (x − xi)2 + ... + y(n)(xi)

n! (x − xi)n. (2.31)

Sendo assim, o polinômio (2.31) é uma função aproximada de y em volta do ponto
xi, em que p1(x) ≈ y(x) é uma aproximação linear, p2(x) ≈ y(x) é uma aproximação
quadrática, p3(x) ≈ y(x) é cúbica, dentre outros.

Conforme Lopes e Ruggiero (1996), com a finalidade de medir o erro local cometido
ao utilizar a aproximação por diferenças, considera-se um ponto ξx entre x e xi tal que a
fórmula de Taylor pode ser expressa por,

y(x) = y(xi) + y′(xi)(x − xi) + y′′(xi)
2 (x − xi)2 + ...+ (2.32)

+ y(n)(xi)
n! (x − xi)n + y(n+1)(ξx)

(n + 1)! (x − xi)n+1.

Assim, para n = 1, a equação (2.32) é descrita da forma,

y(x) = y(xi) + y′(xi)(x − xi) + y′′(ξx)
2 (x − xi)2,

e, no ponto x = xi+1 = xi + h, a equação é dada por

y(xi+1) = y(xi) + y′(xi)(xi+1 − xi) + y′′(ξi+1)
2 (xi+1 − xi)2.
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Ao substituir xi+1 −xi = h na equação e isolar y′(xi), obtém-se a derivada primeira,

y′(xi) = y(xi+1) − y(xi)
h

+ h

2y′′(ξi+1),

em que o último termo representa o erro estimado ao realizar uma aproximação da derivada
primeira pela diferença progressiva, erro esse da ordem de h. Então, aproximando os valores
exatos y(xi+1) e y(xi) por yi+1 e yi, respectivamente, tem-se,

y′(xi) ≈ yi+1 − yi

h
. (2.33)

De forma análoga, é possível constatar que o erro cometido ao utilizar a diferença
regressiva é também da ordem de h. Agora, com o intuito de dimensionar o erro cometido
ao utilizar a diferença centrada, considera-se n = 2 na expressão (2.32), obtendo assim,

y(x) = y(xi) + y′(xi)(x − xi) + y′′(xi)
2 (x − xi)2 + y′′′(ξx)

3! (x − xi)3. (2.34)

Considerando x = xi+1 na equação (2.34) tem-se,

y(xi+1) = y(xi) + y′(xi)(xi+1 − xi) + y′′(xi)
2 (xi+1 − xi)2 + y′′′(ξi+1)

3! (xi+1 − xi)3,

e como xi+1 − xi = h, a equação pode ser descrita na forma,

y(xi+1) = y(xi) + y′(xi)h + y′′(xi)
2 h2 + y′′′(ξi+1)

6 h3. (2.35)

De maneira semelhante, fazendo x = xi−1 na equação (2.34), obtemos que,

y(xi−1) = y(xi) + y′(xi)(xi−1 − xi) + y′′(xi)
2 (xi−1 − xi)2 + y′′′(ξi−1)

3! (xi−1 − xi)3,

como xi−1 − xi = h, tem-se,

y(xi−1) = y(xi) + y′(xi)h + y′′(xi)
2 h2 + y′′′(ξi−1)

6 h3. (2.36)

Então, subtraindo (2.36) de (2.35) e organizando os termos tem-se,

y′(xi) = y(xi+1) − y(xi−1)
2h

− h2

12

[
y′′′(ξi+1) + y′′′(ξi−1)

]
, (2.37)

onde ao considerar a aproximação y(xi+1) ≈ yi+1 e y(xi−1) ≈ yi−1, obtemos,

y′(xi) ≈ yi+1 − yi−1

2h
− h2

12

[
y′′′(ξi+1) + y′′′(ξi−1)

]
. (2.38)

Portanto, a derivada primeira pode ser aproximada pela expressão,

y′(xi) ≈ yi+1 − yi−1

2h
. (2.39)
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De acordo com Lopes e Ruggiero (1996), o erro na fórmula de diferença centrada é
da ordem de h2 e, como h < 1, esta fórmula é mais precisa que as outras duas e, por esta
razão, ela é a mais empregada.

Utilizando novamente a série de Taylor, é possível deduzir também uma aproximação
para a derivada segunda, bem como a expressão para o erro cometido. Para tanto, considera-
se n = 3 na equação (2.32) e utilizam-se os pontos xi+1 e xi−1, obtendo respectivamente
as expressões,

y(xi+1) = y(xi) + hy′(xi) + h2

2! y′′(xi) + h3

3! y′′′(xi) + h4

4! y(iv)(ξi+1), (2.40)

y(xi−1) = y(xi) − hy′(xi) + h2

2! y′′(xi) − h3

3! y′′′(xi) + h4

4! y(iv)(ξi−1). (2.41)

Fazendo a soma de (2.40) com (2.41), obtém-se,

y(xi+1) + y(xi−1) = 2y(xi) + y′′(xi)h2 + h4

24y(iv)(ξi+1) + h4

24y(iv)(ξi−1), (2.42)

isolando o termo y′′(xi) tem-se,

y′′(xi) = y(xi+1) − 2y(xi) + y(xi−1)
h2 − h2

24

[
y(iv)(ξi+1) + y(iv)(ξi−1)

]
. (2.43)

Assim, a aproximação da derivada segunda é dada pela expressão,

y′′(xi) ≈ yi+1 − 2yi + yi−1

h2 , (2.44)

assumindo um erro na ordem de h2.

Uma das aplicações mais clássicas do método das diferenças finitas é na Equação do
Calor, que é a equação diferencial parcial que modela a dinâmica do calor em uma barra.
Neste trabalho, objetiva-se obter a solução numérica da equação do calor unidimensional
por meio do MDF. Destaca-se, desta forma, que as diferenças finitas utilizadas em equações
diferenciais parciais são as mesmas que as utilizadas para discretizar uma EDO, porém,
para EDPs a função incógnita tem duas ou mais variáveis independentes. Sendo assim, a
aplicação do MDF para obter a solução numérica da EDP do calor será desenvolvida no
capítulo (4).
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3 PROCEDIMENTOS METODOLÓGICOS

Para o desenvolvimento deste trabalho, primeiramente realizaremos um estudo
teórico do assunto por meio de artigos científicos, livros, revistas e trabalhos que tenham
relação com o tema da pesquisa. Desta forma, exploramos e investigamos conceitos como
modelagem matemática, equações diferenciais parciais, Problema de Valor de Contorno,
software Scilab e a Equação do Calor, que descreve os problemas associados à teoria do
fluxo de calor.

Posterior a familiarização com a temática, estudaremos sobre a Equação do Calor,
em especial, a formulação da mesma quando a temperatura no meio variar em uma única
direção e o calor for transferido nessa mesma direção. Consequentemente, iremos considerar
as condições de contorno às quais uma haste fina está sendo submetida, para que seja
possível obter as soluções analítica e numérica do problema considerado.

Por fim, para resolver o Problema de Valor de Contorno, utilizaremos inicialmente
o método da separação de variáveis, com o objetivo de obter a solução exata. Para obter a
solução numérica, iremos realizar a implementação computacional do método das diferenças
finitas através do programa Scilab.

Com isso, esta pesquisa pode ser classificada como um estudo de caso, pois consiste
em um aprofundamento de um fenômeno dentro de seu contexto real, de maneira a fornecer
seu amplo e detalhado conhecimento. Desta forma, o propósito da pesquisa é explorar
uma situação real visando proporcionar maior familiaridade com o problema e descrever a
situação no contexto expondo as suas características (GIL, 2017).

Segundo a finalidade da pesquisa podemos classificá-la como aplicada, em razão
de proporcionar conhecimentos para aplicação prática orientados à solução de problemas
específicos. Quanto à abordagem, terá caráter quantitativo, pois demanda o uso de recursos
e técnicas estatísticas objetivando quantificar os resultados de um fenômeno (PRODANOV;
FREITAS, 2013).
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4 ESTUDO DE CASO

4.1 Equação do calor
O estudo dos fenômenos de transferência de calor compreende uma das áreas

fundamentais da engenharia e demais ciências exatas, por consequência dos inúmeros
processos e aplicações que utilizam energia em trânsito. Esses problemas que envolvem a
condução de calor em um sólido são descritos pela Equação do Calor, a qual realiza-se um
estudo nesta seção.

De acordo com Çengel e Ghajar (2012), o calor é a energia térmica que pode ser
transferida de um sistema para outro devido a diferença de temperatura entre eles. Logo,
sempre que existir uma diferença de temperatura em um meio ou entre meios, haverá,
necessariamente, transferência de calor.

Obedecendo um dos enunciados propostos pela termodinâmica, o calor sempre é
transferido de um meio de alta concentração para um meio de baixa concentração de calor,
e esse procedimento é finalizado quando os dois meios atingem a mesma temperatura.
Existem três diferentes tipos de processos pelo qual o calor pode se propagar, que são por
radiação, convecção e condução. Em particular, quando existe um gradiente de temperatura
em um meio estacionário, que pode ser um sólido ou um fluido, é utilizado o termo condução
para se referir à transferência de calor que ocorrerá através do meio (INCROPERA et al.,
2008).

A transferência de calor, ao contrário da temperatura, tem direção e magnitude,
portanto é uma grandeza vetorial. Quanto à taxa de condução de calor em uma direção
específica, tem-se que é proporcional ao gradiente de temperatura, que é a variação da
temperatura por unidade de comprimento. Destaca-se que a taxa de condução de calor
por um meio depende da geometria, da espessura, do tipo do material e da diferença de
temperatura a que o meio está submetido (ÇENGEL; GHAJAR, 2012).

De forma geral, a condução do calor em um meio é tridimensional, dependente do
tempo e da temperatura do meio. Desse modo, os problemas de transferência de calor
podem ser classificados como permanentes ou transientes. O termo permanente implica
que a temperatura não varia em nenhum ponto no meio ao longo do tempo, enquanto
transiente implica variação com dependência do tempo (ÇENGEL; GHAJAR, 2012).

Os problemas de transferência de calor podem também ser classificados como
unidimensionais, bidimensionais ou tridimensionais. No caso mais geral, a condução de
calor em um meio é tridimensional, ou seja, quando a temperatura varia ao longo das
três dimensões espaciais descritas pelas coordenadas x, y e z. Quando a temperatura
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em um meio varia em duas direções e a terceira é desprezível, o problema é considerado
bidimensional. No caso de a temperatura no meio variar em uma única direção e o calor
for transferido na mesma direção, sendo desprezível a condução nas outras duas direções,
então o problema de transferência de calor será considerado unidimensional.

Para fins deste trabalho, realiza-se um estudo acerca da Equação do Calor uni-
dimensional, considerando que esta é a equação diferencial que governa a condução de
calor em sólidos. Segundo Incropera et al. (2008), essa equação determina o campo de
temperaturas em um meio resultante das condições impostas em suas fronteiras, ou seja,
representa a variação da temperatura no meio.

4.2 Características do problema
A Equação do Calor é uma equação clássica da física matemática associada à teoria

do fluxo de calor, isto é, calor transferido por condução em um meio. Ela pode ser aplicada
desde os casos mais simples, como para determinar a variação de temperatura em uma
haste fina, até a condução transiente e multidimensional em geometrias complexas.

A equação do calor unidimensional envolve duas variáveis independentes x e t e
uma variável dependente u(x, t), sendo representada da forma,

k
∂2u

∂x2 = ∂u

∂t
, k > 0. (4.1)

A equação do calor é uma equação diferencial parcial parabólica de segunda ordem
linear, em que a variável x representa uma dimensão espacial, t representa o tempo e a
função u(x, t) é a temperatura. Para dar continuidade, será feita a dedução da equação do
calor unidimensional em (4.1), devido a importância de verificar como tal equação surge.

Considera-se uma haste circular fina de comprimento L, cuja seção transversal tem
área A, feita de um material condutor uniforme de calor tal que coincida com o eixo x no
intervalo [0, L], conforme a Figura 2.

Figura 2 – Fluxo de calor unidimensional

Fonte: Zill e Cullen (2009)

Suponhamos que a superfície lateral da barra esteja isolada termicamente de
modo a não permitir, através dela, transferências de calor com o meio ambiente. Logo, a
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uniformidade do material e o isolamento térmico lateral implicam que o fluxo de calor no
interior da haste se dê somente na direção x, e, portanto, tem-se um problema de condução
do calor em uma única dimensão (FIGUEIREDO, 1977).

Considera-se também que a haste é homogênea, isto é, a sua massa por unidade de
volume (ρ) é uma constante, além de que o calor específico γ e a condutividade térmica K

do material da haste são constantes (ZILL; CULLEN, 2009).

Para obter a equação diferencial parcial que governa a difusão de calor ao longo do
tempo t, em que u(x, t) é a temperatura no ponto x e no instante t > 0, serão necessárias
duas leis empíricas de condução de calor:

(i) A quantidade de calor Q em um elemento de massa m é dado pela expressão

Q = γmu, (4.2)

onde u é a temperatura do elemento.

(ii) A taxa de fluxo de calor Qt através da seção transversal é proporcional à área A da
seção transversal e à derivada parcial em relação a x da temperatura,

Qt(x, t) = −KAux(x, t). (4.3)

onde a constante K é a condutividade térmica do material da haste.

Como o calor flui na direção de decréscimo de temperatura, o sinal de menos na
equação (4.3) é utilizado para garantir que Qt seja positivo para ux < 0, quando o fluxo
de calor ocorre para a direita, e negativo para ux > 0, quando o calor flui para a esquerda.

Considera-se agora uma fatia circular fina da haste entre x e x + ∆x, como exposta
na Figura 2, então u(x, t) pode ser tomada como a temperatura aproximada em cada
ponto no intervalo. Desse modo, a massa da fatia é dada por m = ρ(A∆x), portanto,
substituindo m na equação (4.2), tem-se que a quantidade de calor nela será

Q = γρA∆xu, (4.4)

e, diferenciando a equação (4.4) em relação a t, tem-se uma taxa líquida

Qt = γρA∆xut. (4.5)

Além disso, verifica-se a partir da equação (4.3) que, quando o calor fluir na direção
x positiva, a energia entra no intervalo a uma taxa líquida dada por

Qt(x, t) − Qt(x + ∆x, t) = −KAux(x, t) − [−KAux(x + ∆x, t)] (4.6)
= KA[ux(x + ∆x, t) − ux(x, t)], (4.7)
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logo, igualando à expressão (4.5), obtém-se que
K

γρ

ux(x + ∆x, t) − ux(x, t)
∆x

= ut. (4.8)

Tomando o limite de (4.8) quando ∆x → 0, tem-se que

lim
∆x→0

[
K

γρ

ux(x + ∆x, t) − ux(x, t)
∆x

]
= lim

∆x→0
ut (4.9)

K

γρ
lim

∆x→0

ux(x + ∆x, t) − ux(x, t)
∆x

= lim
∆x→0

ut. (4.10)

Por definição de derivada parcial, segue que

lim
∆x→0

ux(x + ∆x, t) − ux(x, t)
∆x

= uxx, (4.11)

portanto, substituindo essa expressão em (4.10) por uxx, finalmente obtemos a equação do
calor (4.1) na forma:

kuxx = ut (4.12)

onde k = K
γρ

é uma constante positiva chamada difusividade térmica, que depende apenas
do material de que é feita a barra.

Para determinar a distribuição de temperatura em um meio, é necessário resolver a
equação do calor de forma apropriada. Tal solução depende das condições físicas existentes
nas fronteiras do meio, e, se a situação variar com o tempo, a solução também depende
das condições existentes no meio em algum instante inicial (INCROPERA et al., 2008).

Desse modo, como a solução da equação do calor depende do tempo t, é definida
uma condição inicial (CI) para prever a distribuição de temperatura no instante inicial
t = 0. Portanto, uma solução u(x, t) para a equação (4.1) tem que satisfazer a condição
inicial única da forma

u(x, 0) = f(x), 0 ≤ x ≤ L (4.13)

onde f : [0, L] → R é uma função dada que representa a distribuição de temperatura
inicial por toda a haste no instante t = 0.

Além desta condição, é importante saber o que se passa nas extremidades da
barra, tendo em vista que estas não estão isoladas termicamente podendo haver entrada
ou saída de calor. Isso deve, necessariamente, influir no valor de u(x, t). Diversas são as
condições que podem ser impostas nas extremidades da haste, em geral, existem três tipos
de condições de contorno (CC) associadas com a equação do calor, que serão especificadas
na sequência (FIGUEIREDO, 1977).

Sejam então as condições de contorno, especificadas nas extremidades x = 0 e
x = L para um sistema unidimensional, em que a transferência de calor se dá no sentido
positivo da direção x com a distribuição de temperaturas em função do tempo:
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(i) Condição de Dirichlet

u(L, t) = u0, u0 uma constante (4.14)

Esta primeira condição declara que o contorno x = L é mantido de algum modo a
uma temperatura constante u0 para todo tempo t > 0.

(ii) Condição de Neumann
∂u

∂x

∣∣∣∣
x=L

= 0 (4.15)

Esta condição indica que o contorno x = L está termicamente isolado, não havendo
fluxo de calor para dentro ou para fora da haste.

(iii) Condição de Robin
∂u

∂x

∣∣∣∣
x=L

= −h(u(L, t) − um), h > 0 e um constantes (4.16)

A terceira condição representa o calor perdido a partir da extremidade direita da
haste por estar em contato com um meio que é mantido a uma temperatura constante.
A partir da lei do resfriamento de Newton, o fluxo de calor para fora a partir da haste
é proporcional à diferença entre a temperatura u(L, t) no contorno e a temperatura um

do meio circundante. Se o calor for perdido a partir da extremidade esquerda da haste, a
condição de contorno será dada por,

∂u

∂x

∣∣∣∣
x=0

= h(u(0, t) − um). (4.17)

E ainda, há os casos em que as extremidades da haste são especificadas a condições
de contorno diferentes ao mesmo tempo. Contudo, para fins deste trabalho, supõe-se que
as extremidades da barra são mantidas a temperaturas fixas, em especial, considera-se que
u é sempre zero quando x = 0 ou x = L, ou seja,

u(0, t) = 0, u(L, t) = 0, t > 0. (4.18)

Desta forma, conforme Zill e Cullen (2009), ao considerar uma haste fina de
comprimento L com uma temperatura inicial f(x) por toda a haste e cujas as extremidades
sejam mantidas à temperatura zero para todo o tempo t > 0, o problema da condução do
calor consiste em determinar a temperatura u(x, t) na haste a partir do problema de valor
de contorno dado por

k
∂2u

∂x2 = ∂u

∂t
, 0 < x < L, t > 0,

u(0, t) = 0, u(L, t) = 0, t > 0,

u(x, 0) = f(x), 0 < x < L.

(4.19)

Na subseção a seguir, será feita a resolução do PVC descrito na equação (4.19)
utilizando o método da separação de variáveis, método analítico abordado na Seção (2.2.3).



Capítulo 4. ESTUDO DE CASO 38

4.3 Resolução analítica
O problema fundamental de condução de calor é encontrar uma solução u(x, t) que

satisfaz a equação diferencial (4.1) para 0 < x < L e t > 0, sujeita às condições inicial e de
contorno as quais a haste fina está submetida. Desse modo, para obter a solução analítica
do problema de valor de contorno (4.19) será utilizado o método da separação de variáveis,
que consiste em usar a separação de variáveis para determinar uma solução particular do
problema.

Ao verificar que a variável u só aparece na primeira potência em toda equação,
tem-se que o problema de condução de calor é linear. Além disso, a EDP e as condições
de contorno são, também, homogêneas. Isso sugere que é possível abordar o problema
buscando soluções da equação diferencial e das condições de contorno, fazendo depois uma
superposição para satisfazer a condição inicial (BOYCE; DIPRIMA, 2006).

Segundo Boyce e DiPrima (2006), uma solução da equação do calor que satisfaz as
condições de contorno (4.18) impostas nas extremidades da barra é a função u(x, t) = 0,
mas essa solução não satisfaz a condição inicial (4.13), exceto no caso trivial em que f(x)
também é nula. Assim, pretende-se buscar outras soluções, não-nulas, para o PVC (4.19),
por meio da hipótese de que u(x, t) é um produto de duas outras funções, uma dependente
de x e a outra dependendo apenas de t, ou seja, procura-se soluções do problema na forma

u(x, t) = X(x)T (t). (4.20)

Substituindo u dada em (4.20) na equação do calor (4.1), obtém-se

kX ′′T = XT ′, (4.21)

em que a linha se refere à diferenciação usual em relação à variável independente, seja ela
x ou t. A equação (4.21) é equivalente a

X ′′

X
= 1

k

T ′

T
, (4.22)

em que as variáveis estão separadas, isto é, a expressão à esquerda da igualdade depende
somente de x e a expressão à direita depende apenas de t.

Para que a equação dada em (4.22) seja válida para 0 < x < L e t > 0, é necessário
que ambos os lados sejam iguais à mesma constante. Caso contrário, se uma variável
independente fosse mantida fixa e se fosse permitida que a outra variasse, um dos lados da
equação permaneceria constante enquanto o outro estaria variando, violando, portanto, a
igualdade (BOYCE; DIPRIMA, 2006).

Desse modo, se denotarmos essa constante de separação por −λ, então a equação
(4.22) fica

X ′′

X
= 1

k

T ′

T
= −λ. (4.23)
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Destaca-se que consideramos a constante de separação por −λ, ao invés de λ, pois
essa constante será negativa e é conveniente exibir o sinal de menos explicitamente.

A partir da expressão (4.23), obtemos duas equações diferenciais ordinárias para
X(x) e T (t), sendo elas,

X ′′ + λX = 0, (4.24)

T ′ + kλT = 0. (4.25)

Cada uma dessas equações pode ser resolvida imediatamente para qualquer valor
de λ, o que implica que o produto de duas soluções das equações (4.24) e (4.25), respecti-
vamente, fornece uma solução para a equação diferencial parcial (4.1). Contudo, buscamos
apenas as soluções da equação do calor que satisfaçam, também, as condições de contorno,
restringindo assim os valores possíveis para λ.

Substituindo u(x, t) dada pela equação (4.20) na condição de contorno em x = 0,
obtemos

u(0, t) = X(0)T (t) = 0. (4.26)

Analisando a equação (4.26), tem-se que X(0) = 0 ou T (t) = 0. Se a equação fosse
satisfeita escolhendo-se T (t) como sendo zero para todo t, então u(x, t) seria zero para
todo x e t, mas essa possibilidade já foi rejeitada. Portanto, a equação deve ser satisfeita
impondo-se a condição

X(0) = 0. (4.27)

De forma semelhante, a condição de contorno em x = L implica que

X(L) = 0. (4.28)

Considerando a EDO homogênea (4.24) sujeita às condições de contorno homogêneas
(4.27) e (4.28), tem-se a formação do problema de Sturm-Liouville regular:

X ′′ + λX = 0, X(0) = 0, X(L) = 0. (4.29)

Para fazer a resolução do PVC em (4.29), de acordo com Zill e Cullen (2009),
consideram-se três casos possíveis para o parâmetro λ: zero, negativo e positivo.



Capítulo 4. ESTUDO DE CASO 40

i) λ = 0

Para o caso em que λ = 0 obtém-se a equação X ′′ = 0, ou seja, a derivada segunda
é igual a zero. Deste modo, a única possibilidade para a solução geral de (4.24) é da forma

X(x) = c1x + c2. (4.30)

Ao aplicar as condições de contorno X(0) = 0 e X(L) = 0 em (4.30), devemos ter
c2 = 0 e c1L + c2 = 0, o que implica c1 = c2 = 0. E isso resulta na solução trivial X(x) = 0,
o que não nos interessa.

ii) λ = −α2 < 0

Para este caso, obtemos uma EDO linear homogênea de segunda ordem com
coeficientes constantes, dada por

X ′′ − α2X = 0. (4.31)

Com o objetivo de determinar a solução geral desta EDO (4.31), devemos obter as
raízes da equação característica associada à mesma, que é dada por m2 − α2 = 0. Logo,
como as raízes da equação característica são dadas por m1 = α e m2 = −α, temos que a
solução geral de (4.24) será da forma

X(x) = c1e
αx + c2e

−αx. (4.32)

Para satisfazer as condições de contorno X(0) = 0 e X(L) = 0, o par (c1, c2) de
constantes deverá ser solução do sistemac1 + c2 = 0

c1e
αL + c2e

−αL = 0,

contudo, a única solução desse sistema é c1 = c2 = 0, e isso implica também em X(x) = 0.

iii) λ = α2 > 0

Por fim, este último caso fornece uma EDO linear homogênea de segunda ordem
com coeficientes constantes, dada por

X ′′ + α2X = 0. (4.33)

De forma semelhante ao caso anterior, para encontrar a solução geral desta EDO
(4.33), devemos obter as raízes da equação característica associada dada por m2 + α2 = 0.
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Entretanto, as raízes da equação característica são dadas por m = ±αi, assim, por serem
raízes imaginárias, a solução geral de (4.24) será da forma

X(x) = c1 cos αx + c2 sen αx. (4.34)

Aplicando a primeira condição de contorno X(0) = 0 em (4.34), obtemos c1 = 0 e,
portanto, X(x) = c2 sen αx. Assim, a segunda condição de contorno X(L) = 0 implica

X(L) = c2 sen αL = 0. (4.35)

Considerando c2 ̸= 0, tem-se que sen αL = 0, o que implica em αL = nπ e, portanto,
α = nπ

L
onde n = 1, 2, 3, ....

Desta maneira, o problema de valor de contorno dado em (4.29) tem soluções não
triviais quando,

λn = α2
n = n2π2

L2 , n = 1, 2, 3, ..., (4.36)

logo, os valores λn e as soluções correspondentes

X(x) = c2 sen nπ

L
x, n = 1, 2, 3, ... (4.37)

são autovalores e autofunções, respectivamente, do PVC (4.29).

Quanto à equação (4.25), pretende-se determinar a função T (t) que a satisfaz, deste
modo, organizando os termos da equação e integrando em ambos os lados tem-se que,

T ′ = −λkT →
∫ dT

T
=
∫

−λk dt

ln T = −λkt + c

T (t) = c3e
−λkt. (4.38)

Logo, ao substituir λ por n2π2/L2 na equação (4.38), obtém-se que a solução geral
da EDO (4.25) que é dada por

T (t) = c3e
−k(n2π2/L2)t. (4.39)

Portanto, multiplicando as soluções das equações diferenciais ordinárias (4.24) e
(4.25), tem-se

un = X(x)T (t) = Ane−k(n2π2/L2)t sen nπ

L
x, (4.40)

em que An = c2c3. Deste modo, as funções un(x, t) satisfazem a equação diferencial parcial
(4.1) assim como as condições de contorno (4.18) para cada valor inteiro positivo de n.
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Resta, apenas, que a função un indicada em (4.40) satisfaça a condição inicial
(4.13), para tanto, vamos utilizar o Princípio da Superposição, propriedade esta que foi
abordada na seção (2.2.4). Desta forma, tem-se que

u(x, t) =
∞∑

n=1
un =

∞∑
n=1

Ane−k(n2π2/L2)t sen nπ

L
x, (4.41)

em que os termos individuais na série satisfazem a equação do calor (4.1) e as condições
de contorno (4.18).

Para satisfazer a condição inicial, substituímos t = 0 na série infinita (4.41),
obtendo-se,

u(x, 0) = f(x) =
∞∑

n=1
An sen nπ

L
x, (4.42)

expressão esta reconhecida como a série de Fourier em senos de f(x). Em outros termos,
temos de escolher os coeficientes An tais que a série convirja para a distribuição inicial
de temperatura f(x) para 0 ≤ x ≤ L. De acordo com Boyce e DiPrima (2006), seus
coeficientes são dados por

An = 2
L

∫ L

0
f(x) sen nπ

L
x dx. (4.43)

Portanto, uma solução do problema de condução de calor (4.19) é indicada pela
série infinita

u(x, t) = 2
L

∞∑
n=1

( ∫ L

0
f(x) sen nπ

L
x dx

)
e−k(n2π2/L2)t sen nπ

L
x. (4.44)

Destaca-se que o método da separação de variáveis produz um candidato para a
solução da EDP, podendo existir outras soluções que não foram consideradas pelo método.
No entanto, Iório (2018) prova em seu livro a unicidade dos problemas envolvendo a
equação de calor a uma dimensão. Deste modo, o problema (4.19) tem, de fato, uma única
solução, sendo a função indicada em (4.44).

Sendo assim, ao considerar uma haste fina de comprimento L = π com temperatura
inicial u(x, 0) = 100 por toda a haste e difusividade térmica k = 1, cujas as extremidades
sejam mantidas à temperatura zero para todo o tempo t > 0, tem-se que a temperatura
u(x, t) na haste, com 0 < x < π, é determinada a partir do PVC dado por

∂2u

∂x2 = ∂u

∂t

u(0, t) = 0

u(π, t) = 0

u(x, 0) = 100.

(4.45)
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Desta forma, a partir de (4.43), verifica-se que os coeficientes An para a solução do
problema de valor de contorno (4.45) são definidos por

An = 2
π

∫ π

0
100 sen nπ

π
x dx

An = 200
π

∫ π

0
sen (nx) dx

An = 200
π

[−1
n

cos(nx)
]π

0

An = 200
π

[−1
n

cos(nπ) + 1
n

cos(0)
]

An = 200
π

[−(−1)n

n
+ 1

n

]

An = 200
π

[1 − (−1)n

n

]
. (4.46)

E, portanto, conforme a solução geral apresentada em (4.44), a solução analítica
u(x, t) do PVC (4.45) é indicada pela série infinita

u(x, t) = 200
π

∞∑
n=1

[1 − (−1)n

n

]
e−n2t sen (nx). (4.47)

4.4 Resolução numérica
A solução numérica da Equação do Calor será obtida por meio do Método das

Diferenças Finitas, cuja ideia básica consiste em aproximar as derivadas que aparecem na
equação original por fórmulas de diferenças finitas. Além do mais, neste método numérico,
o domínio contínuo da equação é substituído por uma malha de pontos, por meio de um
processo de discretização.

Para obter a solução numérica do PVC do calor (4.19), em vez de trabalhar com a
região semi-infinita no plano xt definida pelas igualdades 0 ≤ x ≤ L e t ≥ 0, será utilizada
a região retangular definida por 0 ≤ x ≤ L e 0 ≤ t ≤ T , onde T é algum valor específico
de tempo. Sobre essa região, posiciona-se uma malha retangular constituída por retas
verticais espaçadas por hx unidades e retas horizontais afastadas ht unidades entre si.
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Desta forma, ao escolher quaisquer dois inteiros positivos n e m, obtém-se que,

hx = L

n
e ht = T

m
,

então as retas verticais e horizontais da malha são definidas por

xi = ihx, i = 0, 1, 2, ..., n e tj = jht, j = 0, 1, 2, ..., m.

Inicialmente, objetiva-se obter a solução numérica do PVC (4.45), desta forma,
considera-se uma haste fina de comprimento L = π com temperatura inicial u(x, 0) = 100
por toda a haste e difusividade térmica k = 1, cujas as extremidades sejam mantidas à
temperatura zero para todo o tempo 0 < t < 6, assim a temperatura u(x, t) na haste, com
0 < x < π, é determinada a partir do PVC,

∂2u

∂x2 = ∂u

∂t

u(0, t) = 0

u(π, t) = 0

u(x, 0) = 100.

(4.48)

A primeira etapa da aplicação do MDF consiste em definir o domínio discreto onde
a solução será buscada, em particular, para o caso apresentado anteriormente, tem-se
uma região retangular definida por 0 ≤ x ≤ π e 0 ≤ t ≤ 6. Para discretizar o domínio,
a princípio divide-se o intervalo [0, π] em n = 6 subintervalos igualmente espaçados, em
que cada subintervalo têm comprimento hx = π − 0

6 = π

6 . A Figura 3 apresenta a malha
unidimensional para quando n = 6.

Figura 3 – Malha unidimensional quando n = 6

Fonte: Os autores (2021)

Para definir o espaçamento ht, adota-se a relação

λ = kht

h2
x

, (4.49)

em que k > 0 é a constante de difusividade térmica. Esta relação vem da discretização
da equação do calor pelo MDF. Como condição de estabilidade do método numérico, é
necessário que λ ≤ 1

2 , caso contrário o método é considerado instável, isto é, quando
os erros de arredondamento ou qualquer outro erro crescem muito rapidamente com a
realização dos cálculos (ZILL; CULLEN, 2009).
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Sendo assim, admitindo λ = 1
4 obtém-se que

ht = λh2
x

k
=

1
4 ·
(

π

6

)2

1 = π2

144 ≈ 0, 068539. (4.50)

Portanto, sobre a região definida por 0 ≤ x ≤ π e 0 ≤ t ≤ 6, posiciona-se uma
malha retangular formada por retas verticais espaçadas por hx = π

6 unidades e retas

horizontais afastadas ht = π2

144 unidades entre si, ou seja, as retas verticais e horizontais
são definidas por,

xi = π

6 i, i = 0, 1, 2, ..., 6

tj = π2

144j, j = 0, 1, 2, ..., 88.

Para aproximar a solução u(x, t) da equação do calor unidimensional (4.1), devemos
substituir as derivadas por quocientes de diferenças. Em particular, requer aproximações
para a derivada segunda na variável espacial e para derivada primeira na variável tempo.
Deste modo, utiliza-se a aproximação por diferença central de segunda ordem na variável
espacial, dada por,

∂2u

∂x2 ≈ 1
h2

x

[u(x + hx, t) − 2u(x, t) + u(x − hx, t)], (4.51)

e, a aproximação por diferença progressiva de primeira ordem na variável tempo, expressa
da forma,

∂u

∂t
≈ 1

ht

[u(x, t + ht) − u(x, t)]. (4.52)

Com isso, substituindo as aproximações (4.51) e (4.52) na EDP do calor (4.1),
obtém-se a equação

k

h2
x

[u(x + hx, t) − 2u(x, t) + u(x − hx, t)] = 1
ht

[u(x, t + ht) − u(x, t)], (4.53)

ou ainda, adotando as simplificações u(x, t) = uij , u(x+hx, t) = ui+1,j , u(x−hx, t) = ui−1,j

e u(x, t + ht) = ui,j+1, obtém-se a equação discretizada para cada i,

kht

h2
x

[ui+1,j − 2uij + ui−1,j] = ui,j+1 − uij, (4.54)

a qual, considerando a relação λ = kht

h2
x

e isolando o termo ui,j+1, pode ser reescrita como,

ui,j+1 = λui+1,j + (1 − 2λ)uij + λui−1,j. (4.55)
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Essa equação pode ser escrita para todos os nós interiores da barra. Ela então
fornece um meio explícito de calcular valores em cada nó para um instante futuro baseado
nos valores atuais no nó e em seus vizinhos. Considerando j = 0 na expressão (4.55),
obtém-se uma fórmula para as aproximações da temperatura u na primeira reta de tempo
dada por,

ui,1 = 0, 25ui+1,0 + 0, 5ui,0 + 0, 25ui−1,0. (4.56)

Logo, adotando i = 1, 2, 3, 4, 5 na última equação (4.56), obtém-se, respectivamente,

u1,1 = 0, 25u2,0 + 0, 5u1,0 + 0, 25u0,0

u2,1 = 0, 25u3,0 + 0, 5u2,0 + 0, 25u1,0

u3,1 = 0, 25u4,0 + 0, 5u3,0 + 0, 25u2,0

u4,1 = 0, 25u5,0 + 0, 5u4,0 + 0, 25u3,0

u5,1 = 0, 25u6,0 + 0, 5u5,0 + 0, 25u4,0.

A critério de conhecimento, para compreender a técnica das diferenças finitas, a
equação u2,1 apresentada acima, pode ser reescrita como,

u2,1 = 0, 25u(x3, t0) + 0, 5u(x2, t0) + 0, 25u(x1, t0), (4.57)

deste modo, como xi = π

6 i e tj = π2

144j, tem-se x1 = π

6 , x2 = π

3 , x3 = π

2 e t0 = 0. Portanto,
a equação em (4.57) torna-se

u2,1 = 0, 25u
(

π

2 , 0
)

+ 0, 5u
(

π

3 , 0
)

+ 0, 25u
(

π

6 , 0
)

. (4.58)

A partir da condição inicial u(x, 0) = 100, a última equação torna-se

u2,1 = 0, 25 · 100 + 0, 5 · 100 + 0, 25 · 100 = 100

Sendo assim, tem-se que u2,1 = 100 é uma aproximação para a temperatura

u(x2, t1) = u
(

π

3 ,
π2

144

)
, cuja solução analítica é dada por,

u
(

π

3 ,
π2

144

)
= 99, 532213. (4.59)

De maneira semelhante, é realizada a aproximação da temperatura u em cada
ponto do domínio discretizado e, então realizam-se comparações entre a solução analítica
e a numérica.

Devido as inúmeras etapas de manipulação de dados envolvidas nos processos de
simulação numérica, é inevitável o surgimento de erros que interferem no resultado final.
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Em vista disso, a análise dos erros inerentes ao processo faz-se necessária com o propósito
de validar o método utilizado (CUNHA, 2000).

De acordo com Lopes e Ruggiero (1996), o erro pode ser expresso como erro
absoluto (EA), obtido pela diferença entre o valor exato (x) e o valor aproximado (x̄),
isto é, EA = |x − x̄|. Contudo, por vezes o erro absoluto não é suficiente para descrever
a precisão do cálculo, então utiliza-se o erro relativo (ER), que considera a ordem de
grandeza dos números envolvidos e é definido por,

ER = |x − x̄|
|x̄|

. (4.60)

Quanto à solução numérica, foi realizada a implementação computacional da
equação (4.55) por meio de um código desenvolvido no software Scilab. O Scilab é um
software livre de alto rendimento com linguagem de programação simples, que apresenta
uma variedade de funções matemáticas e ferramentas que proporcionam a resolução de
cálculos de certa complexidade.

Os valores resultantes da simulação numérica foram escritos em arquivo, para que
fossem utilizados na análise gráfica. Os gráficos em 3D e em 2D foram construídos pelo
software livre Gnuplot.

Deste modo, a Figura 4 ilustra a superfície gerada pela temperatura ao longo da
barra com o passar do tempo quando n = 6 subintervalos.

Figura 4 – Temperatura u(x, t) ao longo da barra no decorrer do tempo com n = 6

Fonte: Os autores (2021)
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Entretanto, verifica-se que para n = 6 a quantidade de subintervalos no eixo
horizontal é insuficiente para se ter uma solução aproximada com boa precisão. Isso
fica claro pela ocorrência de altos erros ao comparar a solução analítica e a numérica.
Visualmente, a Figura 4 mostra as várias oscilações no gráfico. Para contornar este
problema, deve-se aumentar o número de subintervalos no eixo horizontal, o que também
acarreta em aumento no número de subintervalos no eixo vertical (tempo).

Assim, visando melhorar a solução apresentada anteriormente, o problema de valor
de contorno (4.48) também foi resolvido para n = 100 subintervalos, assim, tem-se que
hx = 0, 031416 e, admitindo λ = 0, 5, tem-se que ht = 0, 0004935, ou seja, m = 12159
subintervalos no eixo t.

Desta forma, a Figura 5 apresenta o gráfico 3D da temperatura ao longo da barra
com o passar do tempo quando n = 100. Como já era esperado, o aumento do número
de nós da malha gera uma aproximação cada vez melhor, assim, se verifica com maior
intensidade o princípio da condução do calor.

Figura 5 – Temperatura u(x, t) ao longo da barra no decorrer do tempo com n = 100

Fonte: Os autores (2021)

Alternativamente, com o auxílio da aplicação de gráficos 2D, traçamos a solução
u(x, t) como uma função de x para vários tempos fixos e como uma função de t para várias
posições fixas na haste. O gráfico exposto na Figura 6 mostra a variação da temperatura
no comprimento da barra para os tempos fixos de t = 0, 1, t = 0, 5, t = 1, t = 2 e t = 4.
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Figura 6 – Variação da temperatura ao longo da barra com t fixo quando n = 100

Fonte: Os autores (2021)

A excelente concordância das soluções analítica e numérica ilustrada na Figura 6 é
confirmada pelo baixo erro relativo obtido. A Tabela 1 apresenta estes resultados para
alguns instantes fixos do tempo.

Tabela 1 – Erro relativo (ER) obtido para diferentes instantes de tempo, com n = 100

Instante de tempo ER(%)
0, 1 0, 2858
0, 5 0, 0576
1, 0 0, 0499
2, 0 0, 0658
4, 0 0, 0987

Fonte: Os autores (2021)

Já a Figura 7, apresenta o gráfico da variação da temperatura no decorrer do tempo
para os comprimentos fixos de x = 0, 3, x = 0, 5, x = 1 e x = 1, 5.

Novamente tem-se uma excelente concordância das soluções analítica e numérica
ilustrada na Figura 7, que é confirmada pelo baixo erro relativo obtido. A Tabela 2
apresenta estes resultados em algumas posições fixas na haste.
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Figura 7 – Variação da temperatura no decorrer do tempo com x fixo quando n = 100

Fonte: Os autores (2021)

Tabela 2 – Erro relativo (ER) obtido em diferentes posições na haste, com n = 100

Posição fixa na haste ER(%)
0, 3 0, 2927
0, 5 0, 1619
1, 0 0, 1311
1, 5 0, 1311

Fonte: Os autores (2021)

Comparando-se as soluções analítica e numérica, observa-se que o Método das
Diferenças Finitas obteve excelente precisão na aproximação numérica da solução da
equação do calor unidimensional. O método se mostra muito útil para obtenção da
resolução de PVCs, principalmente onde não se tem uma solução analítica ou nos casos
em que a solução analítica é difícil de se obter.
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5 Considerações Finais

Com este trabalho, é possível concluir que o método das diferenças finitas mostrou-se
eficaz na simulação da condução de calor unidimensional em uma haste fina, pois aproximou
de forma satisfatória o resultado numérico do analítico. E, além disso, constatou-se que a
ampliação do número de pontos dicretos do domínio forneceu melhores resultados, isto é,
houve uma redução do erro relativo entre a solução analítica e numérica.

Deste modo, os objetivos propostos neste trabalho foram alcançados, já que foi
possível determinar uma solução aproximada para o problema de condução de calor e
obter o comportamento da distribuição da temperatura ao longo da barra.

No que tange os estudos realizados ao longo da construção desse trabalho, verifica-se
que este viabilizou um grande enriquecimento acadêmico ao propiciar um aprofundamento
dos conhecimentos relativos às equações diferenciais e aos Problemas de Valor de Contorno,
além de possibilitar um estudo significativo acerca dos problemas de condução de calor
em sólidos. Permitiu, também, a aplicação de um método numérico aliado ao software
Scilab para simulação de um problema representado por uma equação diferencial parcial e
a comparação dos resultados obtidos analítica e computacionalmente.

Para este trabalho, considerou-se a Equação do Calor unidimensional, logo, para
trabalhos futuros, fica como sugestão considerar problemas em que a temperatura em
um meio varia em duas ou três dimensões, ou seja, problemas de transferência de calor
bidimensionais ou tridimensionais.
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Introduction
PDF/A is a standardized version of the pdf file format and it is intended for
archiving and long-term preservation of electronic documents. A PDF/A file
must contain all of the information necessary for displaying and printing the
document. This includes text, graphics, fonts and color information. Audio
and video content and encryption is forbidden.


The first version of the PDF/A standard, PDF/A-1, was published in 2005.
Since then, two newer versions have been published, PDF/A-2 in 2011 and
PDF/A-3 in 2012. Earlier versions contain a subset of the features of later
versions.


The PDF/A-1 standard specifies two conformance levels, PDF/A-1a and
PDF/A-1b. Level a (accessible) meets all requirements for the standard. Level
b (basic) conformance requires only that the document’s visual appearance
is preserved. PDF/A-2 and PDF/A-3 contain a third level u (Unicode), which
expands conformance level b with an additional requirement that all text in
the document have Unicode mapping.


PDF/A format is required in Tampere University theses. Any PDF/A
version and conformance level can be used.


Creating a PDF/A file
Below is a LATEX template for creating a PDF/A compliant file:


\begin{filecontents*}[overwrite]{\jobname.xmpdata}
\Title{Document’s title}
\Author{Author’s name}
\Language{en-US}
\Subject{The abstract, or short description.}
\Keywords{keyword1\sep keyword2\sep keyword3}
\end{filecontents*}
\documentclass[a4paper,12pt]{article}
\usepackage[utf8]{inputenc}


1



https://en.wikipedia.org/wiki/PDF/A

https://libguides.tuni.fi/theses/pdfa





\usepackage[T1]{fontenc}
\usepackage{colorprofiles}
\usepackage[a-2b,mathxmp]{pdfx}[2018/12/22]
\hypersetup{pdfstartview=}
\begin{document}
The text of the document goes here.
\end{document}


The pdfx macro package
A PDF/A file is generated from LATEX source with the pdfx package:


\usepackage[a-2b,mathxmp]{pdfx}[2018/12/22]


The option a-2b selects PDF/A version and conformance level. The default
value is a-1b. The option mathxmp enables the use of mathematical symbols in
metadata. It also corrects some errors in presenting metadata in pdf viewers,
thus its use is recommended. The option [2018/12/22] at the end of the
command means that no version of the package older than the specified date
is accepted. The pdfx package has still some shortcomings and problems and
there are more of these in the older versions.


The pdfx package loads hyperref and xcolor packages, among others, so
you don’t have to call these explicitly. Hyperref options can be set using the
\hypersetup command.


Color profile
The colorprofiles package takes care of the color profile, which is required
by the PDF/A format. The pdfx package loads colorprofiles automatically.
However, pdfx will not call colorprofiles, if it is not installed. So it must be in-
stalled first. In MiKTeX missing packages are usually installed automatically
when needed, in which case it is sufficient to add the command


\usepackage{colorprofiles}


before calling the pdfx package.


Metadata
The PDF/A standard requires that document metadata, such as document’s
title, author’s name and keywords, is embedded in a specified format. The
pdfx package reads this metadata from a text file \jobname.xmpdata, where
the command \jobname contains the basename of the document’s main LATEX
file, for example pdfa-guide.xmpdata. Usually the most convenient way is to
include the \jobname.xmpdata file at the beginning of the main file, within
a filecontents* environment:
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\begin{filecontents*}[overwrite]{\jobname.xmpdata}
\Title{Document’s title}
\Author{Author’s name}
\Language{en-US}
\Subject{The abstract, or short description.}


\Keywords{keyword1\sep keyword2\sep keyword3}
\end{filecontents*}


If your version of LATEX was released before October 2019, the overwrite op-
tion of the filecontents* environment does not work. In that case, replace
the command


\begin{filecontents*}[overwrite]{\jobname.xmpdata}


with commands


\RequirePackage{filecontents}
\begin{filecontents*}{\jobname.xmpdata}


All the supported metadata fields are listed in the documentation of the pdfx
package. None of the metadata fields are mandatory, but it is recommended
to specify at least the \Title and \Author fields.


Multiple authors, keywords and languages should be separated by \sep.
This ensures that metadata processing software will interpret different au-
thors etc. clearly separate.


Within the metadata fields, LATEX’s reserved characters $, &, #, _, ~, ^,
{ and } represent themselves, but the characters % and \ must be marked
with the commands \% and \textbackslash. This means that, for example,
superscripts and subscripts can only be represented with the corresponding
Unicode characters.


If the metadata fields contain mathematical symbols, either as Unicode
characters or represented with LATEX’s commands, you must use the mathxmp
option of the pdfx package. Notice that mathematical symbols must not be
surrounded with dollar signs, because these would show in the metadata as
such.


Checking and validating a PDF/A file
After the PDF/A file is ready, check in Adobe Acrobat Reader or in PDF-
XChange Editor its text, images, bookmarks, links and metadata (File →
Properties → Description). Lastly, you must ensure that the file actually
complies with the PDF/A standard. This validation must be done always
before archiving PDF/A files, either self-produced or received from another
source.


PDF/A files can be validated with the following programs:


• 3-Heights PDF-validator online tool is a free tool for PDF/A validation.
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• veraPDF is a free open source PDF/A validator. veraPDF requires the
Java Runtime Environment. A quick start guide: https://docs.verapdf.
org/gui/.


• Adobe Acrobat Pro’s Preflight tool (Tools → PDF Standards → Pre-
flight) can validate PDF/A files and repair possible validation errors.
Acrobat Pro is commercial software, but a 7-day trial version is avail-
able.


• Callas pdfaPilot can validate and repair PDF/A files in a similar manner
as Adobe Acrobat Pro. Callas pdfaPilot is commercial software, but a
14-day trial version is available.


Sometimes these validation programs may give different results. Usually it is
sufficient that the file validates with one of the above mentioned programs.
Thus if a pdf file passes the validation tests of one program, you do not have
to validate it with other programs. If a pdf file fails the tests of one program,
you can test it with another program.


Recommendations and problems


Bookmarks
Check the document’s section titles in Adobe Reader’s or in PDF-XChange
Editor’s bookmarks. Avoid using mathematical symbols in section titles, be-
cause mathematical symbols and other special characters may not show up
correctly in bookmarks. In many cases these can be corrected with the com-
mand \texorpdfstring{}{}, whose second argument is used in the book-
marks. For example,


\section{The integral \texorpdfstring
{$\displaystyle\int\sqrt{x^2 - a^2}\,dx$}
{\int\textsurd(x\texttwosuperior \textminus


a\texttwosuperior)\unichar{"2009}dx}}


The second argument of \texorpdfstring can contain Unicode characters,
either copied from somewhere or entered with the \unichar{"XXXX} com-
mand, where XXXX is the character’s hexadecimal code in uppercase.


Included pdf files
If a LATEX document contains included pdf files, for example graphics, these
files must have their fonts embedded. Otherwise the pdf file produced from
the LATEX document does not contain those fonts and will not pass PDF/A
validation. The included pdf files do not necessarily have to be in PDF/A
format. Embed the fonts with the same programs with which the included
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pdf files were made. If this is not possible, the fonts can be embedded with
the free Ghostscript program1. The required command in Windows command
prompt is


"C:\Program Files\gs\gs9.52\bin\gswin64c.exe" -dBATCH
-dNOPAUSE -sDEVICE=pdfwrite -dAutoRotatePages=/None
-sOutputFile=output.pdf -c "<</NeverEmbed [ ]>>
setdistillerparams" -f input.pdf


The file path at the beginning of the command depends on the version
of Ghostscript. If you need other than Ghostscript’s default fonts, the list
of font directories can be given with the option -sFONTPATH. For example,
-sFONTPATH="C:/Windows/Fonts".


Limitations of the pdfx package
The current version (v1.6.3) of the pdfx package cannot generate level a (1a,
2a, 3a) conforming PDF/A files.


When using pdfLaTeX, a valid PDF/A-1b file cannot be created either.
However, with XeLaTeX it is usually possible. It is not necessary to change
the LATEX code when switching from pdfLaTeX to XeLaTeX.


The pdfx package expects that XeLaTeX is used with the optional argu-
ment -shell-escape. Because the use of -shell-escape is a security risk,
it is better to create a new processing tool than to change XeLaTeX’s default
options. In the TeXworks editor this is done as follows:


1. Select Edit → Preferences → Typesetting.


2. Click the plus button next to Processing tools.


3. Create a new processing tool ”XeLaTeX shell-escape” according to fig-
ure 1, when using MiKTeX, and according to figure 2, when using TeX
Live.


The macro packages arev, kpfonts and mathdesign prevent PDF/A files
from validating, thus these packages should not be used. In some cases other
font defining macro packages can also cause validation errors. If this happens,
try first another validation program. If the file validates with that, the prob-
lems are probably not too serious. Another solution is to switch to XeLaTeX
and PDF/A-1b. If this does not help either, a third option is to use the Latin
Modern fonts provided by the lmodern package, which usually does not cause
any problems.


The option pdfstartview of the hyperref package selects the pdf viewer’s
startup page view. The values FitH, FitV, FitR, FitBH and FitBR of this


1You will also need the Ghostscript fonts: https://sourceforge.net/projects/gs-fonts/
files/latest/download. Copy the fonts folder to Ghostscript’s installation directory.
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Figure 1: Adding the option -shell-escape in MiKTeX.


Figure 2: Adding the option -shell-escape in TeX Live.


option will cause a validation error in 3-Heights PDF validator. These val-
ues should therefore not be used. If the option is given without a value as
pdfstartview=, then the pdf viewer’s default setting is used as the startup
page view.


PDF/A conversion with other programs
Try first to create the PDF/A file with LATEX, because then at least the doc-
ument metadata will be in the required format. If a valid PDF/A file cannot
be created with LATEX, another program must be used for the conversion.


Muuntaja service
The students and staff of Tampere University can create PDF/A files with the
Muuntaja service on the page https://muuntaja.tuni.fi/. Write the document
metadata first with LATEX.
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PDF-XChange
PDF-XChange is a software package for creating and editing pdf files. PDF-
XChange Editor can save pdf files in PDF/A format. Select File → Save as
and then choose Save as type: PDF/A Document (*.pdf). Write the document
metadata first with LATEX.


PDF/A conversion with PDF-XChange Editor version 7 or older breaks
the links in the pdf file. This problem is fixed in version 8.


Adobe Acrobat Pro
If you have Adobe Acrobat Pro, you can repair PDF/A validation errors with
its Preflight tool (Tools → PDF Standards → Preflight). In Preflight select
the Profiles view, then choose the desired conversion profile from the PDF/A
group, and finally click the Analyze and fix button in the lower right corner
of the window.


Acrobat Pro can also convert ordinary pdf files to PDF/A format:


1. Create an ordinary pdf file with LATEX.


2. Open the file in Adobe Acrobat Pro.


3. Edit document metadata: File → Properties → Description.


4. Save as PDF/A: File → Save As Other → Archivable PDF (PDF/A).


5. Validate and, if necessary, repair the file with the Preflight tool.


Callas pdfaPilot
Callas pdfaPilot can create and repair PDF/A files in a similar manner as
Adobe Acrobat Pro. Editing document metadata with Callas pdfaPilot is
difficult, so write the metadata with LATEX instead.


PDFen
PDFen is an online service for converting documents to pdf or PDF/A format.
After registration you can select PDF/A version and conformance level from
the link More options. Up to seven PDF/A files per month can be created
with the free version. The metadata cannot be edited.
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